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Особенности системы 
автоматизированного проектирования 

Mentor Graphics

Современная система проектирования печатных плат представляет 
собой сложный комплекс программ, обеспечивающий сквозной 
цикл проектирования и технологической подготовки 
производства, начиная с черчения принципиальной схемы и 
заканчивая генерацией управляющих файлов для оборудования 
изготовления фотошаблонов, сверления отверстий, сборки и 
контроля электрических параметров.

Выбор конкретной САПР определяется назначением устройства, 
функциональной ориентированностью, стоимостными и 
сервисными характеристиками (приобретение, сопровождение, 
обучение). 

Больших результатов на рынке САПР добилась компания 
Mentor Graphics



Основа стратегии компании Mentor Graphics – системный 
подход и концентрация усилий на наиболее 

перспективных секторах мирового рынка проектирования 
электронных систем. 

В число шести важнейших прикладных областей, которыми 
занимается компания вошли



 
Продукты компании Mentor Graphics



Продукты компании Mentor Graphics



Mentor Graphics предлагает три базовых маршрута 
проектирования ПП:



Первые два маршрута ориентированы на корпоративных 
пользователей и самые сложные современные ПП. PADS 
продвигают, как решение для небольших рабочих групп 
специалистов. Однако разделение это носит условный характер 
и определяется в основном стоимостью, набором функций и 
возможностями расширения.

Компания Mentor Graphics развивает и поддерживает все три 
указанных маршрута, но наибольшее внимание уделяется 
развитию Expedition. Именно в нем компания старается 
отразить все самые современные тенденции в проектировании 
ПП. В Expedition поддерживаются все основные форматы 
технологических файлов для производства ПП, а именно: 
Gerber, ATE, AIS Drill. Дополнительные возможности в плане 
адаптации к требованиям конкретного оборудования, а также 
общей автоматизации выпуска технологических файлов 
предоставляет модуль CAM Output Manager.



Три варианта поставки Expedition PCB:



Полный маршрут проектирования высокоскоростных 
проектов включает в себя следующие ключевые 

продукты:



• В DxDesigner, множество инженеров могут одновременно работать на одном проекте, без процесса 
разбиения\слияния. Сделанные одним инженером изменения, немедленно отражаются в главной базе данных и 
видны всем в группе, таким образом интерфейсы  между листами схем всегда синхронизированы. В 
дополнение к классическим символам схем, DxDesigner поддерживает табличный ввод компонентов и 
соединений. Это особенно актуально для компонентов с очень большим количеством выводов, где схемный 
символ может занять несколько страниц.

• I/O Designer™ является быстрым и эффективным решением для назначения выводов ПЛИС\ИМС в топологии 
плат. Если есть необходимость переставить выводы на плате для дальнейшего улучшения топологии, I/O 
Designer укажет какие выводы можно переставлять, а какие нет. I/O Designer также отслеживает соответствие 
между маршрутами проектирования ПЛИС и платы, выступая в качестве инструмента для управления 
данными, он контролирует каждый маршрут и управляет любыми внесенными изменениями.

• HyperLynx® обеспечивает пред и пост топологический анализ целостности сигналов, наводок и ЭМС, как для 
тра как для традиционных высокоскоростных соединений, так и SERDES и DDR3 технологий.

• HyperLynx Analog™ верифицирует аналоговые и смешанные аналог\цифра разработки на системном или 
платном уровне. диционных высокоскоростных соединений, так и SERDES и DDR3 технологий. 

• Library Manager обеспечивает возможность разрабатывать и управлять библиотекой находящейся в центре из 
одного места. Это помогает гарантировать целостность данных всех разрабатываемых и обслуживаемых 
библиотек. Вы можете управлять Центральной Библиотекой, управляя содержанием и доступом пользователей 
к разделам и библиотечным данным. 

• LP Wizard программа для создания посадочных мест компонентов по стандарту IPC-7351B для различных 
САПР. 

• Решения PADS, разрабатываемые компанией Mentor Graphics охватывают весь спектр разработки печатных 
плат, от ввода принципиальной схемы до технологической подготовки производства.

• Платформа разработки топологии Xpedition PCB направлена на решение основных проблем разработки систем 
на печатных платах



Основные функции и преимущества 
топологического редактора Expedition PCB



Возможности Expedition PCB  в отношении 
параметров печатных плат



Улучшенное планирование и размещение:

❑ модернизированный алгоритм размещения, использующий 
иерархическую группировку компонентов;

❑ настраиваемая пользователем визуализация соединений для групп, 
отдельных компонентов или областей проекта;

❑ управление цепями для систематизации, изменения и защиты от 
изменений параметров важных компонентов и групп цепей.



Ускоренная трассировка:

❑ Sketch Router позволяет пользователю контролировать 
расположение трасс, стили трассировки и стиль переходных 
отверстий;

❑ упрощена визуализация и исправление ошибок в проекте;

❑ эффективная, качественная трассировка и оптимизация 
дифференциальных пар, включающая автоматическую 
синхронизацию фаз, симметричное соединение с контактными 
площадками и закругление трасс;

❑ улучшенная визуализация соединений трасс и препятствий на их 
пути.



Интуитивно-понятная, эффективная среда 
разработки:

❑ графический интерфейс оптимизирован для повышения 
простоты и удобства использования;

❑ вспомогательные средства, облегчающие обучение и 
привыкание, включающие в себя персонализацию, 
позволяющую сфокусироваться на наиболее часто 
используемых функциях;

❑ оптимизирована работа с цепями и компонентами, чтобы 
воплотить намерения разработчика и упростить доступ к 
важным данным.



Сравнительный анализ
 Mentor Graphics Expedition 

PCB и Altium Designer 
Summer 2009



Замена корпуса и контактной площадки в Mentor 
Graphics и Altium Designer.

            Процесс смены контактной площадки или корпуса в Mentor Graphics 
достаточно сложен, т.к. ЭРЭ, который указан в net-листе, упакован в 
библиотеке созданной самим разработчиком, как правило, с одним 
корпусом. Поэтому чтобы заменить корпус, его нужно внести в библиотеку 
проекта, затем подключить запись для пополнения списка, т.е. привязать 
сменяющий корпус или контактную площадку к элементу на котором нужно 
сделать изменения. Например: заменить корпус микросхемы DD1.



Выбрать корпус который нужно изменить, затем нажать Pin Mapping, в 
открывшимся окне выбирать корпус для замены и нажать ОК.

В меню ЕСО-> Replice Cell выбрать корпус элемента который нужно 
заменить, в правой части окна выбрать элемент для замены и из 
выпадающего списка выбрать корпус для замены, далее Apply и Ок.
 

Корпус изменен.

Setup -> Part Editor ->

В результате корпус элемента DD1 изменен.



Чтобы заменить контактную площадку микросхемы DD1.

 Setup -> Сell Editor -> на вкладке Package выбрать корпус элемента контактную 
площадку которого нужно изменить, далее в столбце Package Group выбрать 
Discrete – Other, затем в столбце Mount Type выбрать тип: Mixed. Далее нажать 
кнопку Edit Graphics,  затем в открывшемся редакторе Cell Editor нужно 
изменить выводы элемента нажав Place pins в ячейке Pins – Padstack name из 
выпадающего списка. Затем закрыть окно Place pins, сохранить изменения в Cell 
Editor и снова закрыть.

Окно 
редактора 
Cell Editor



        В Altium Designer замена корпуса или контактной площадки отличается 
тем, что корпус для замены выбирается из любой библиотеке подключенной к 
проекту. Библиотек подключенных к проекту может быть несколько, как 
встроенных непосредственно в программу, например Miscellaneous 
Devices.IntLib, так и созданных самим разработчиком. 

       Замена осуществляется следующим образом: Необходимо выделить 
элемент, затем двойным кликом открыть его свойства, далее в открывшемся 
окне Component в  нижней секции Footprint в строке Name из списка выбрать 
корпус элемента на который нужно заменить.

Измененный 
корпус  

элемента 

корпус  элемента
для изменения 

Окно Component



 Изменение языковых настроек.
     В Altium Designer смена языка осуществляется через меню
     DXP->Preferences, далее поставить флажок Localization и кнопку 

Display localized hints only и флажок Localized menus, затем нажать 
Apply, выйти из программы и снова зайти. Изменения вступят в силу.

 Mentor Graphics не является русифицированным приложением, смена языка в 
этой программе невозможна.



Функция Multi Plow  в Mentor Graphics и Altium Designer

Функция Multi Plow в режиме Route Mode в Mentor Graphics имеет множество 
преимуществ по сравнению с этой же функцией в Altium Designer. 
     Во–первых проводники проведенные от одной микросхемы к другой заводятся на 
нее автоматически, в Altium Designer каждый проводник нужно заводить на свой pin 
отдельно в ручную. 
     Во–вторых, в процессе ведения проводников удобно использовать кнопки 
расположенные в нижней части окна редактора PCB, с помощью этих кнопок можно 
автоматически расширять или сужать расстояние между проводниками, ставить 
переходные отверстия, а также автоматически завершать трассировку разводимых 
проводников.



Автоматическое завершение 
разводки проводников с 
помощью F5 Auto finish

Проводники собираемые в веер 
могут располагаться удаленно 
друг от друга.



     

В Altium Designer Interactive Multi-Routing осуществляется иначе: 
сначала нужно нарисовать несколько проводников, затем выделить их, 
нажать команду Interactive Multi-Routing Connections  и вести.

Подводя проводники к контактным 
площадкам подсоединять их нужно 
по одному. 
Это существенно затрудняет работу. 



Создание корпуса печатной платы в Mentor Graphics 
и Altium Designer.

В Altium Designer заложены развитые средства управления геометрией 
объектов. Для формирования контура заготовки следует воспользоваться 
функцией PCB Board Wizard в которой можно задать геометрические размеры 
платы, ее форму, количество слоев и другие свойства, затем когда структура 
заготовки сформирована ее можно редактировать через меню Desing ->Board 
Shape далее выбрать нужную функцию, например изменение формы платы.



            В Mentor Graphics контур платы удобнее импортировать файлом DXF из 
любого графического редактора AutoCad, NanoCad, Solid Works. Для этого 
нужно открыть меню    File-> Import-> DXF     

             При создании проекта в Mentor Graphics контур платы создается по 
умолчанию сразу, если корпус простой прямоугольный, редактировать его 
можно через Properties в режиме Draw Mode. Рисование сложного контура в 
Mentor Graphics выполняется заданием координат отрезков, радиусов дуг, 
которые затем объединяются в полилинию, процесс это трудоемкий поэтому 
удобнее импортировать сделанный корпус в формате DXF из AutoCAD.



Отчеты в Mentor Graphics и Altium Designer

 В Mentor Graphics отчеты можно увидеть через
       Каждый файл формата txt размещен в дереве проводника и отражает 
информацию об ошибках разводки (DRC), количество, размер, наличие 
металлизации переходных отверстий, Schematic net-list, информацию о 
Gerber файлах и др. Таблицу NC Drill можно вывести на экран через панель 
Display Control, также ее можно сохранить в формате DXF для дальнейшего 
оформления КД в AutoCAD. Распечатать таблицу NC Drill можно, как в 
файле txt так и в DXF. 

File Viewer на панели Standart.



             В Altium Designer данные сверления NC Drill Files имеют 
несколько выходных форматов для изготовления:**.DLP, DRR, DRL, 
TXT. Для оформления КД файл экспортируется в формате DXF, 
однако таблица сверления отверстий не экспортируется, как в Mentor 
Graphics. Информацию по составлению таблицы можно получить 
только из отчета в меню Reports-> Board Information



 3D модель печатной платы в Mentor Graphics и Altium 
Designer.

       В программе Altium Designer 3D модель можно увидеть с помощью 
меню Tools -> Legacy Tools -> Legacy 3D View. На просмотре можно 
изменить только положение модели и цвет проводников. Вносить 
изменения можно через меню Tools -> Manage 3D bodies for Components. 
В Mentor Graphics подключить 3D модель возможно с помощью Solid 
Works экспортируя файл библиотеки элементов и файл корпусов. Далее 
работа с моделью осуществляется в этой программе. 

 3Dмодель Altium Designer                                  3D модель в программе Solid Works





Выводы: 
         В Mentor Expedition PCB поддерживаются все основные форматы технологических 
файлов для производства ПП, а именно: Gerber, ATE, AIS Drill а также существует удобный 
экспорт в DXF для дальнейшего оформления КД.
         В Mentor Expedition PCB процесс разводки очень удобен:

❑вспомогательные команды разводки находятся в нижней строке окна программы, что 
позволяет не использовать ввод с клавиатуры, это ускоряет процесс трассирования печатной 
платы;

❑ также автоматическая раздвижка трасс, препятствующих проведению трассы, при полном 
сохранении связности трассировки делает процесс разведения легче;

❑ осуществляется постоянный динамический контроль и индикация возникающих при 
трассировке нарушений правил проектирования; 

❑диагональная трассировка (по направлениям, кратным 45°) с учетом реальных 
геометрических форм всех объектов на плате; 

❑автоматическое сглаживание трасс для уменьшения числа сегментов и устранения острых 
углов. 

❑удобный интерфейс программы достигнут с помощью панели Display Control на которой 
отражена вся основная информация о слоях, деталях, цепях. Диалоговое окно Display Control 
главным образом использовано для управления отображением графики, что делает работу с 
программой более удобной.

❑пакет программ Mentor Graphics разделен на части Desing Capture и Expedition PСB, каждую 
из которых можно установить по отдельности, это является плюсом, так как устанавливая их 
отдельно можно экономить место на жестком диске. После установки обоих частей 
программа занимает 3,2 ГБ, Designer Summer 2009 занимает около 2ГБ на диске.



Выводы:
 Altium Designer Summer 2009 отличается от Mentor Graphics Expedition PCB: 

❑   большим объемом набора команд;
❑   активным использованием горячих клавишь;
❑   более объемной структурой проекта;
❑   большим количеством каскада окон вызываемых команд;
❑   включает в свой состав особые команды, например, авторазмещение,  

используемое не всегда, а только при проектировании очень сложных проектов.

       Структура проекта Expedition PCB более лаконична, но при этом обладает не 
меньшей гибкостью настроек и управления.

      Основными  недостатками Expedition PCB является:
❑ отсутствие перехода программы на русский язык, как это реализовано в Altium  

Designer Summer 2009;
❑ Mentor Graphics не выпускает собственных библиотек элементов, поэтому до 

создания проекта разработчику необходимо сделать свою библиотеку чтобы 
подключить ее при создании проекта. Библиотека ODA является сторонним 
приложением разработанным специально для Mentor Graphics и покупается 
отдельно от программы. 

❑ Mentor Graphics Expedition PCB более дорогое приложение чем Altium Designer 
Summer 2009 стоимость за одну лицензию составляет от 6000$. 


